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For More Information

Thank you for downloading this software. Icon Designer 2.0 is an icon creating and editing 
program for people who are not satisfied with the icons that are shipped with the applications 
they buy, or need custom icons that can be used to represent their different documents in 
program manager. Whatever your reason is for using this software, no matter what level of 
computer expertise you are at, You will find Icon Designer 2.0 an easy, intuitive, and fun 
program to use. Just click on the Visual description of tools below to get a quick lesson on what 
the different buttons and menus do. This program operates just like any other painting program 
with one exception; the size of the canvas will always have a dimension of 32x32 pixels.

About The Author.
System Requirements.
Visual Description Of The Tools.
A Description Of The Samples Included.
The Different Ways Of Starting Icon Designer.
Changing Program Manager Icons.
Importing 32x32 256 Color Bitmaps.
Editing The Color Palette Of An Icon.



ICON DESIGNER 2.0 FOR WINDOWS
Just click on the item you need help on and a description of the item will appear.



Use this menu for opening, closing, creating and renaming
icons. The command for importing 256 color bitmaps is also 
here. Also used for exiting Icon Designer.



 Use this menu for copying, pasting, and undoing any
actions that you taken to change the icon. It also contains the
command for editing the color palette of the current icon.



Use this menu for selecting tools, colors, and performing
different rotations and flops on an icon.



Use this menu for selecting different windows. And also
showing and hiding the tool palette, the color palette, the toolbar
and the status bar. Commands for arranging minimized windows
can also be found here including cascade, tile, and arrange.



Use this menu for accessing this help file, and also showing
the about dialog box displaying information on the developer.



File Buttons.
These buttons perform the same operations
that can be found in the File menu. Including
Open..., Save, and New...



Edit Buttons
These buttons perform the same operations
that can be found in the edit menu. Including
Copy and Paste.



Undo Button
This button will undo the last edit operation.



Background Color Buttons.
These Buttons will move through the different
colors that the icon will rest on. This is handy
for previewing the icon on different backgrounds.



Rotation Buttons
These buttons will rotate the icon in either
a counterclockwise or clockwise direction.



Show\Hide Color Palette Button
This button will toggle between either
showing or hiding the color palette.



Show\Hide Tool Palette Button
This button will toggle between either
showing or hiding the tool palette.



Help Buttons
These buttons will perform the same
operations as the help menu.



The Main Edit Window.
This is where you will do all your editing of your icon. If you need
to see the icon at its normal size, just click on the editing window
with the right mouse button. To return to the normal editing mode,
simply click on the editing screen with the right mouse button again.



The Color Palette
Use this array of buttons to select the current
editing color for all editing operations. Each button
is color coded for easy selection. If this palette is
hidden, color can still be selected by using the color
menu under the tools menu.



The Status bar
This bar informs you of the options that each menu
and button is capable of. When a tool or color is selected,
this bar will inform you of both the color and tool.



The Erase Tool
This tool erases to a clear background.



The Pencil Tool
This simple tools operates exactly like a pen.



The Flood Fill Tool
This tool will fill an area bounded by the color
on the spot where cursor was clicked with the
currently selected color up to any other color.



The Straight Line Tool
This tool draws a straight line from one spot to another.
Just click on the starting point. While the left button is still
pressed, drag the cursor to the ending point and release
the mouse.



The Empty Rectangle Tool
This tool draws an empty rectangle from one spot to another.
Just click on the starting point. While the left button is still
pressed, drag the cursor to the ending point and release
the mouse.



The Filled Rectangle Tool
This tool draws a solid rectangle from one spot to another.
Just click on the starting point. While the left button is still
pressed, drag the cursor to the ending point and release
the mouse.



The Empty Ellipse Tool
This tool draws an empty ellipse from one spot to another.
Just click on the starting point. While the left button is still
pressed, drag the cursor to the ending point and release
the mouse.



The Filled Ellipse Tool
This tool draws a solid ellipse from one spot to another.
Just click on the starting point. While the left button is still
pressed, drag the cursor to the ending point and release
the mouse.



Using Custom Colors

Although Icon Designer defaults to the standard sixteen color palette, these colors can be 
altered to suit your needs. An advantage to using this feature is the ability to render your icon 
with colors that more closely match what you are drawing. An example of this would be using 
colors that match skin colors when drawing a persons face. The standard palette has no color 
that would be a satisfactory match for this color. To do this, you    can simply replace one or 
more of the colors you would not be using in this icon. This feature does not extend the color 
depth of your icon. You are still limited to sixteen colors. If 16 custom colors are not enough for 
you, you may consider using 256 color icons by using the Import... command in the file menu.

Icon Designer has five predefined custom palettes and five user definable palettes. The five 
predefined palettes are Grey Scale, Fleshtones, Grass, Sky, and Fire. These palettes provide 
the user with a nice array of blue, green, and red combinations that can be mixed with each 
other. There is no limit to the amount of color substitutions you can make in an icon. When a 
color is edited however, any portion of the icon that is drawn with this color is updated with the 
new color.

Warning: When you edit a color, the color selector palette and color selector menu item will 
not show the new color. The palette will still show the original color. This can get very confusing 
when working on several icons at the same with several substitutions in each since each icon 
has their own color palette that is not reflected in the color selector. It is recommended that if 
you are working with custom colors, you should only have one icon open at a time.

It is recommended that you consistently replace colors with shades of a similar color. A good 
example of this would be always substituting the brown color with a skin tone shade when 
needed. This makes editing an icon that has a custom palette a lot easier since you would 
naturally assume the proper substitution.

Using Custom Colors On Different Displays: Since different displays have different 
capabilities as far as resolution and color depth, great care is needed in designing your icon 
files. If an icon with custom colors is viewed on a sixteen color display, it's going to look like shit.
A good idea is to make two different icons in two separate files with different names. You may 
experience some problems with this type of icon depending what type of system you have and 
the display adapter in use. Experimentation with different types of icons should be done to 
insure that your icons look good.



Importing 32x32 256 Color Bitmaps: Another useful tool included with Icon Designer, is 
the ability to import 32x32 256 color bitmaps. These bitmaps can then be saved as standard 
icon files while retaining their 256 color depth. These bitmaps can be created by most painting 
programs. If this approach is too much or your display will have problems with 256 color icons, 
you can use 16 color icons that have their palettes adjusted to your personal tastes. To do this, 
you simply select the Edit Color Palette... menu item from the Edit menu.

Limitations: Since Icon Designer can not directly edit these imported bitmaps with the 
exception of rotating and flopping the images, it is recommended that the color balance and 
contrast be adjusted before they are imported. This also includes any painting that need to be 
done. If any painting is attempted on these images, the painting tools are simply ignored. 
Another limitation of importing 256 color bitmaps as icons is the inability of Icon Designer to 
create 256 color icons that have clear spots. All icons created this way will be 32x32 of solid 
colors that will block the background.

Black & White, 16 color, and 24 bit true color bitmaps are not supported.

There are three rules for importing bitmaps, they are:
1. They must be 256 colors.
2. They must be 32x32 pixels.
3. They must not have any compression.

Using 256 Colors On Different Displays: Since different displays have different 
capabilities as far as resolution and color depth, great care is needed in designing your icon 
files. If an icon with 256 colors is viewed on a sixteen color display, it's going to look like shit. A 
good idea is to make two different icons in two separate files with different names and color 
depths. You may experience some problems with this type of icon depending what type of 
system you have and the display adapter in use. Experimentation with different types of icons 
should be done to insure that your icons look good.



About The Author And This Program: This software was created by Robert P. Smyth 
using Microsoft Visual C++ 2.0 using the Microsoft Foundation Classes supplied with it. It is a 
new version of software I originally created three years ago. There were many shortcomings in 
the original Icon Designer that needed to be addressed; including the single document interface 
of the original and its quirky operation when used on high resolution displays. This software was
checked out on 640x480, 800x600, and 1024x768 resolutions with 16, 256, and    16,000,000 
color depths. This software was run on these video systems using the debug version of 
windows, showing absolutely no problems. If there are any problems with this software, you can
email me at my COMPUSERVE address. I'm going to start on the new version of this software 
as soon as I recover from creating this one.

System Requirements.
Visual Description Of Tools.
A Description Of The Samples Included.
Ways Of Starting Icon Designer
Changing Program Manager Icon

Freeware: This software is not shareware, it is freeware. What this means is I expect 
absolutely no fee for this software. It can be distributed freely to anyone from anyone. I 
encourage everyone to copy this software and give it to anyone who wants it. It can be 
uploaded on any BBS as long as they charge only for the connect time for downloading of the 
software.



System Requirements: This software will run on any PC equipped with a 386 processor and 
a mouse running Microsoft Windows version 3.1 or above. It is highly recommended that a true 
color display be used for icons that have custom palettes or 256 color icons.



 Written by Robert P. Smyth
If you have any comments about this software.
You may email me through CompuServe.
COMPUSERVE ADDRESS 74244,3454



Sample Icon Files: This software comes with many different sample icon images. Most of 
these samples have been collected from different sources including my own photo CD. The 
Setup program created several sub-directories under the directory that you specified when 
installing Icon Designer. These directories are called \256CLR, \TOONS, \APPS, and \
CUSTOM. The \TOONS directory contains various wacky cartoon like icons. The \APPS 
directory contains icons that can be used for some of the popular applications you may use. The
\CUSTOM directory contains icons that make use of the Custom Palette option in the Edit 
menu. The \256CLR directory contains 256 color icons that were imported from 32x32 256 color
bitmaps that were imported into Picture Publisher and edited and shrunk to 32x32 pixels.

Warning: If you attempt to view the icons in either the \CUSTOM or \256CLR directories 
without a display adapter and its true color drivers loaded that will enable Windows to display 
the proper amount of colors needed by these icons will see some very lousy looking icons. 
There should be a minimum of approximately 65,000 colors available. 256 colors are not 
enough.

These samples can be a good start in learning how to edit and customize your own icons. 
Although creating an icon looks easy, it is not. Creating a good looking icon can be difficult.



The Icon Resource File Format: Icon resource files created by Icon Designer are 
specialized bitmaps that contain several structures that Program Manager can read as an icon. 
These files usually end with an .ICO extension.    The format of these files are    as follows.

Var Size Var Name 16 Color Value | 256 Color Value
------------------------------------------------------------------------------------------
UINT Reserved 0
UINT Type 1
UINT Count 1 
BYTE Width 32
BYTE Height 32
BYTE ColorCount 16 | 0
BYTE Reserved 0
UINT Planes 1
UINT BitCount 4 | 8
DWORD BytesInRes 744 | 2216
DWORD ImageOffset 22
DWORD Size 40
LONG Width 32
LONG Height 32
UINT Planes 1
UINT BitCount 4 | 8
DWORD Compression 0
DWORD SizeImage 0
LONG XPelsPerMeter 0
LONG YPelsPerMeter 0
DWORD ClrUsed 0
DWORD ClrImportant 0
------------------------------------------------------------------------------------------

The rest of the file contains either 16 4 byte color tables or 256 4 byte color tables depending on
the color depth. Then there is an array of bytes that represents the actual image. Each byte 
either contains index information for two pixels (16 color) or each byte will contain index 
information for one pixel (256 color). In a 16 color icon, there will be 512 of these bytes, and a 
256 color icon will have 1024 bytes. The file then end with 128 bytes that will contain information
on the AND values for each pixel. This information is either a 1 or a 0. This means that 8 pixels 
worth of information can be store in each byte. The size of this array remains the same for both 
256 color and 16 color. Although, the 256 color icon will not really make use of it. The 256 color 
icon will simply clear all of these last 128 bytes to 0. These bytes control the clear portions of 
your icons. This is why 256 color icons created with Icon Designer can never have clear 
sections.



Changing Program Manager Icons: When you install a program, Program Manager 
usually selects an icon from within the executable program file of the installed program. For 
example: when you installed Icon Designer, Program Manager searched inside 
DESIGNER.EXE for a suitable icon that matches most closely the resolution and color depth of 
the display adapter you are using. When an icon is found, a copy of the icon resource is copied 
into the Program Managers group file (*. GRP). This icon can be substituted by using the 
Properties command in the File menu.

An example of this is as follows:

To change default Write icon to your to MYWRITE.ICO.

1. Create and Edit MYWRITE.ICO
2. Save MYWRITE.ICO to the directory that contains WRITE.EXE
3. Switch to Program Manager.
4. Select the group that contains Write.
5. Select Write by single clicking it.
6. Pull down the File Menu.
7. Select the properties command.
8. Click on the Change Icon button.
9. Enter MYWRITE.ICO in the filename.

What about other Windows shells: Any shell that is compatible for windows should have 
no problem with icon resource files. I use PC Tools for windows and have had no problem with 
any of the files created by Icon Designer.



Starting Icon Designer: When you ran Icon designer for the first time, all files with an .ICO 
extension were associated with Icon Designer. What this means is, all files with the .ICO 
extension will be considered a document that is associated with Icon Designer. What this does 
is this allows you to launch Icon Designer by double clicking on any icon Resource files. Icon 
Designer will be launched with the double clicked icon file(s). This is useful for opening many 
files at once.

Drag and Drop: Icon Designer supports the drag and drop features of the Windows File 
Manager. To use this feature, simply select the icon(s) in file manager and then drag these files 
over Icon Designer and released them. It does not matter if Icon Designer is minimized or 
restored. When these files are released on top of Icon Designer, Icon Designer will create new 
documents with the images of the files dropped on Icon Designer. Some Windows shells allow 
you to launch an application by simply dropping the associated document(s) on the application 
icon while it's not even running; therefore launching the application with the document loaded. 
This can be done with Icon Designer.

Command Line Options: Icon Designer can automatically load an icon on startup by 
specifying the pull path of the icon to be loaded. An example of this would be: C:\DESIGNER\
DESIGNER.EXE C:\DESIGNER\256CLR\COLIN.ICO




